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GETTING STARTED 

LOGGING INTO MYED 

Log into MyEd by selecting MyEd from the 

SD28 home page or by pressing Ctrl-Alt-M 

on any school district computer.  You will 

need to enter your login ID and password.  

Your login ID will be something like 

johnsmith28.  Note that no capital letters 

are allowed. 

If it is your first time you will need to login 

using the temporary password you were provided and then enter a new password.  The requirements for a 

password are shown at the right.   

These are acceptable passwords: Sitting4$, Cloudy_2day, F8ful_day and Work_4me.  These are not: sitting4$ (no 

capital), Cloudy2day (no symbol), F8ful_d (too short) and Work_forme (no number). 

The second time you log in you will need to enter your email address and a question/answer combination.  These 

will be used in the very unlikely case that you forget your password.  You can just click the Forgot my password 

link on the login page and will be sent an email allowing you to enter a new password.  These can BE CHANGED 

THROUGH THE PREFERENCES OPTION (SEE PAGE 7). 

START-UP PAGE 

Once you log on, you will see the welcome page with multiple functions.  

• Student Changes 

• Group Resources 

• Published Reports 

• System Maintenance & Announcements 

• Privacy Act links 

Student Changes shows changes to demographics that have been made to students at the school you are logged 

in to see.  

(See next page for more information)  
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STUDENT CHANGES 
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NAVIGATING IN MYED 

Most navigating in MyEd is with a series of tabs along the top (called top-tabs) and tabs down the left side (called 

side-tabs).  There may also be sub-tabs (called leafs) along the top and down the side. 

 

 

Under the top-tabs are a few menu choices to perform actions specific to the screen.  You will note that the 

reports are available within the screen you are working in, not in a separate report section of the program. 

Breadcrumbs show how you got to the screen – you can click on them to go back to previous screens.  Do not use 

your browser’s back button! 

The record navigation bar can be used to move to the first, previous, next or last record. 

At the very top are a personal settings bar and a Log Off button.  Do not use the browser’s red X to leave MyEd. 

TERMINOLOGY IN MYEDUCATIONBC  

Some terms are used in MyEd in novel, interesting ways that may surprise you: 

Primary school – is the home school of the student (has nothing to do with student age) 

Secondary school – is a school the student is cross-enrolled in (has nothing to do with student age) 

YOG (Year of Graduation) – is unfortunately often used in place of grade.    

     For the 2016-2017 school year, the conversion is        YOG = 2029 – Grade         or          Grade = 2029 – YOG 

Active/Inactive – Active students are presently in the school, inactive students are withdrawn 

Year – MyEd refers to 2017-2018 as the 2018 school year  
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SETTING YOUR PREFERENCES 

You can configure a number of user preferences to make using 

MyEd faster and easier. Click on the down arrow beside your 

name on the settings bar, and then click Set Preferences. You 

will see five tabs but only need to worry about two of them. 

General 

• Default locale = Canada (this sets the date format) 

• Default view = School 

• Auto-save interval (personal choice) 

• Records per page: Must be between 5-35 

• Warn on save (personal choice) 

Security – set your email address and a security question 

to allow a reset of your password in the very unlikely 

event you forget it.  

REGISTERING STUDENTS 

RESTRICTED QUERY FOR STUDENT  

When registering a student to your school, you must first figure out if they are already in MyEd or not. 

A) If they are in MyEd, you will find them and make changes to their demographics etc.   

B) If they are not already in the system you will start from scratch (Part B page 9)  

 

FIRST STEP – try to find them.  From the student list, use the Options menu to select Registration – Register 

Student.  This will start the student registration wizard.  

Enter the legal last name, gender and 

birthdate from Birth Certificate or BC 

Services Card.   

 
(If the student is a sibling of a present student 

in the school, do not yet check the box “New 

family member”.  Do the search first, and if 

the student does not already exist, start again 

and check this box.  More under Registration 

on page 8-9) 

 

If a student with the same surname 

and gender and a birthdate within 45 

days was found in another MyEd 

school you will see a list like the one shown here.    

Check Name, DOB, gender and grade; If the correct student is in the list, select the student and click OK.  
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COMMUNICATE WITH PREVIOUS SCHOOL 

If the student is not found, you may need to select “Create a new student”, but first:  

 

Before creating a new student record, take the time to do some detective work.    

Ask the student or parent if there is a different name that might have been used at the last school (or 

Strongstart).  Ask what school they last attended, and if it is in BC try to contact that school to see if they may 

have used a different name, gender or birthdate.  Only if you are convinced that the student has not previously 

attended a MyEd school (or Strongstart) you should enter the information to create a new student record. (Part B-

page 9) If not, click Cancel again and come back later.   

Remember, if you register a new student without ensuring the student has never been in a MyEd school, you will 

likely create a duplicate record and cause many headaches for yourself and others. 

For some students there may be one more place to look: 

the archive of old records.  If a student was registered in 

a MyEd or BCeSIS school in the past but not in the past 4 

years, they may be in the archive.  If the student meets 

these criteria, click the Options menu, and select Flag 

Student for Retrieval, enter the student PEN, Legal First 

Name, Legal Last Name, Gender and DOB.  The student 

record will be retrieved from the archive overnight and 

you should be able to find them the next day.  

 

REGISTERING A SIBLING OF A PRESENT STUDENT 

When registering a new student that has a 

sibling at the district, check the New Family 

Member box in the first step of the 

registration wizard.  By entering the family 

member’s last name and home phone number 

you can search for a sibling. This will 

automatically assign the same address and 

link contact information for the new student. 

(Very convenient-but only for new students)  

Siblings are shown in MyEd as a form of contact 

called Related Students.  The relationships are 

shown in the Contacts side-tab, Related Students 

leaf.  Please keep “relationship” to sibling. 
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REGISTER A STUDENT – PART B (STUDENT NEW TO MYED)  

Once you have decided to register a student new to MyEd you can complete the steps on the wizard.   

Click on “create a new student” if step 2 doesn’t populate. 

On Step 2, have the Birth Certificate or BC Services card in 

front of you and carefully enter the Legal last name, First 

name and Birthdate.  (Check the formatting on the 

birthdate to make sure it’s correct.) 

Dates will always display in the format: dd/mm/yyyy  

(i.e. 24/01/2005).  Phone numbers should be entered in this 

format: 250-123-1234. 

 You can also fill in phone number, Homeroom number and Home language here.  

Clicking the Next button will take you to step 3 

of the registration wizard.  Don’t ask why – just 

smile as you enter the year of graduation and 

check that the correct grade is calculated.  For 

Strongstart students the correct YOG will be 

(Present Year + 18 – Student Age as of Dec. 

31st).  The grade level should then stay at EL 

throughout the Strongstart years and 

magically transform to KF when the student 

enters Kindergarten.  The Enrollment status for 

a pre-reg Kindergarten student should be set 

at PreReg. 

You need to select the Calendar for each 

student.  The only choice is Standard. 

Enter the date of registration and select a Code 

that makes sense to you. 

Once you have registered a brand new student, you need to go find them in your list of students to input the rest 

of the demographics. (Pre-reg Kindergarten students will be in PreReg Students in your filter) 

 

ENTER DEMOGRAPHICS  

Fields you should enter on the demographics tab are: 

• Usual names 

• Proof of age – a birth certificate or other document should be copied and kept in the student file 

• Student email – this will be something like johnsmith@sd28.org  

• Who has Custody 

• BC Personal Health Number (Care Card) 

mailto:johnsmith@sd28.org
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• Homeroom 

• Calendar (should be set to Standard) 

• Family Courier (youngest and only) 

ENTER ADDRESSES  

When entering addresses it is important to follow the Canada Post conventions.   

Otherwise two addresses that should be the same (i.e. for siblings) may not 

match because of slight differences. If you are unsure of the convention, 

click the … beside the address.  If you see this warning  the address was 

entered incorrectly. Click OK and then the Validate button.  If the error was 

something like an unexpected comma it will be removed, but for something more complex you will see another 

warning.   

Some common errors are: 

• Using Road, Street or Avenue instead of Rd, St or Ave 

• Not putting a space in the 

middle of the postal code 

Once you have corrected the address 

you will be able to Validate and not 

see an error.  Note that an address on Hwy 97 N is entered as N Hwy 97. 

Remember to link shared address with families living in the same house. To do so, type in the beginning of the 

address and pause...  The address should appear with the family name connected to it.  Click on the 

name/address you want to link and the address will auto-fill.  You will now see the address is shared.  If you click 

on the shared icon:                  you will see whom the contact shares an address with.  

There is also a field to select the document used to provide proof of residence.  

 

ENTER ALERTS  

There are three types of alerts: 

• Legal: entered only when a custody or restraining order or other legal document is on file . 

The description should note that there is a document in the student’s file, with the date of the 

document.  If no document exists it should be an Other type of alert. (You will also need to add an Inclusion 

for any legal documents, please see Inclusions section) 

• Medical:  a life-threatening medical condition  (You will also need to add an inclusion for life-threatening 

medical conditions, please see Inclusions section) 

• Other – Family: notes if the student is staying away from home or other family–related information  

• Other - Information: other information that requires an alert  

• Other – Health: a non-life threatening medical condition or other health-related information  
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CITIZENSHIP, LANGUAGE AND CULTURE 

 

Citizenship information includes visa details country of birth.  Language and Culture includes the 

home language, Aboriginal Ancestry and Band of Residence.   

ASSIGN PROGRAMS  

Ensure previous programs have an end date. 

Programs are assigned in the Membership side tab, Programs leaf, including Core French, 

Aboriginal-Other approved Programs, English as a Second Dialect 

• Secretaries are responsible for adding Core French to students grades 5-7. This will need 

to be done when a new student enters the school, and yearly for all new grade 5 students.  

• The Aboriginal Education program is entered by the secretary at AbEd yearly. You can 

contact AbEd if you have a new self-identified Indigenous student registering and they will 

follow up with program participation.  

To add a program, you must first click on the dictionary icon and select General Program. Then 

select Options - Add.  Select the program name for the program code field.   

  

 

                  

 

When selecting the school, a long list will appear. To quickly find your school, click on the Description header to 

sort the field, press Ctrl-F, and type the name of your school. (Or just type in the school name in the field) 

To add a program to multiple students at once, you can use a query or filter to get the list of students you want 

to change, then use Options – Assign Student Programs. 

All programmed assignments for students at your school can be seen using Global- Favorites- Student Program 

Participation.    

Check student groups in the Student top tab> Membership side tab – Groups leaf.  Delete if no longer applicable. 

(Groups can be created in the School top tab>Groups side tab. These can be assigned to an ‘adult responsible’ and 

members can be added for viewing by staff. This works well for music teachers for example.) 

 

Program Name Code 

Core French 11002 

Aboriginal-Other approved program 11008 

English as a second dialect 11005 
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ASSIGN PERMISSIONS  

 

Forms are sent out to students to conform the following permissions: 

• Send Email and Auto dialer Calls? (default Yes) 

• Release of Info/Photos Outside of District (default Yes-change if necessary 

when forms come in) 

• Permission to walk home (default No) 

• Allow Internet Access (default Yes-change if necessary when forms come in) 

• Field Trip Permission (leave blank) 

• In addition, there is a memo field for any school-specific permission information. 

ENTER PARENT/GUARDIAN/EMERGENCY CONTACTS INFORMATION 

When adding a new contact, it is important to find out if he/she is already in MyEd. There should be no duplicate 

contacts.  There should be one shared contact linked between children, e.g. one Snow White linked to each of 

the Seven Dwarfs (not seven Snow Whites).   

Parent/Guardian Information and emergency contacts are shown below detail side tab under Student.  To add a 

new contact, click Options, Add.  

Contact priority numbers should start at 1, not 0.   

SEARCH FOR A CONTACT BEFORE CONTINUING:  

Type in the contacts last name, click on the magnifying glass and from the pop-up screen, select “All Contacts” 

(do not select all people).   

1) If the contact’s name, address and phone number match, select that contact—congratulations, this is a 

match! Selecting this person will automatically enter the phone number, address and workplace.   

2) If only some of the information matches, do some detective work and find out if it is really the same 

person, and if it is, make sure any other school with other students linked to the contact knows you are 

about to change that information.  

3) If you are sure they are not in MyEd, hit Cancel and this will continue on creating a new contact and enter 

the rest of the demographic information.  There will be a non-shared icon next to the last name:  

NOTE: If you change a contacts name, it will change that contact for all linked students.  Be sure before you do so.  

You cannot clear a contacts name and add a new one, e.g. “Rita Smith is no longer an Emergency contact, her 

husband Henry Smith is now, so I’m just going to change the first name to Henry since all the other information is 

the same.”  You must delete Rita from the contact list and Add Henry.   
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Parents or guardians should have the Parental Auth box checked and be set as Regular Contacts. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Emergency Priority number: should never be 0, start priority numbers at 1 

Title: For mailing purposes 

Legal first name: Must be consistent for an easier duplicate search (e.g. Robert not Bob) 

Legal last name: Make sure it isn’t in the system yet, use search button. 

Usual first name: If they go by a different name, use it here. (Bob) 

Relationship: Very important this is correct for verification forms 

Type: Also important that this is correct for verification forms.  

 

     Check marks for all Parent/guardians: 

Receive grade mailing 

Receive conduct mailing 

Receive other mailing 

Receive email (important to select if typing in an email)  

Parental Auth or Guardian 

Check only if applicable: 

Contact can pick up 

Contact lives with student (if they live with them part time, but different address, do not check this box as it will 

not show up on verification forms) 

Include on IEP 

Volunteer 

Do NOT check: 

Contact has family portal access 

Emergency contacts should have the Type set to Emergency, and ‘pick up’ box ticked if stated on reg form.    

Search 

Shared 
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*Delete previous emergency contacts from other 

districts 

Note that all email addresses must include @ and 

cannot include spaces. If the contact is to receive 

your school newsletter or other mailings they will 

need the Receive email box checked. 

Shared addresses: If a contact lives with the 

student, make sure to create a ‘shared’ address.  To 

do so, type in the beginning of the address and pause…  The address should appear with the family name 

connected to it.  Click on the name/address you want to link and the address will auto fill.  You will now see the 

address is shared.  If you click on the shared icon:         you will see who the contact shares an address with.  

 

**If you realize you have made a mistake with a students’ first, last or middle name, or the DOB after 

registering at any point of the year, do not simply change the mistake.  You must contact the PENs   

coordinator and scan the legal ID to update their information as well. PENS.coordinator@gov.bc.ca  

 

CHILDREN OR YOUTH IN CARE (CYIC) of the Ministry of Children and Family Development are identified on the 

demographics page. If a social worker has been assigned guardianship, they should be entered as the #1 contact. 

On the demographics tab, check the box “CYIC or YAG”, and choose “Social Worker” from the drop-down menu 

in the Who Has Custody? field.  

The Agreement or Order field refers to MCFD custody agreements not all guardianship/custody agreements 

(these should be indicated as a legal alert/inclusion). MCFD custody agreements include:  

 

 

mailto:PENS.coordinator@gov.bc.ca
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ASSIGN COURSES TO A STUDENT (ELEMENTARY) 

In MyEd there is a course for every subject in every grade.  These courses have descriptions and course codes. 

The course codes begin with M for standard ministry courses, F for French immersion courses and X for non-

ministry courses (usually courses or comment blocks for which there is no mark – only a comment).   

For example: 

• MEN--04 English Language Arts (Grade 4) 

• FEPSF--04 Education Physique et Sante (Grade 4) – French Immersion P.E. 

• XTC--07  Term Comment (Grade 7) – a block for a term comment for the report card 

Each course has one or more sections, one for each class that has that course.  We have named all sections to 

correspond with the homeroom numbers.  For example: 

• MMA--04-L3 Mathematics (Grade 4) for homeroom L3 (at Lakeview) 

• MSC--03-C2 Science (Grade 3) for homeroom C2 (at Carson) 

 

These are the steps to assign the course sections to a 

newly registered student (mid-year):  

• From the student list, click on the student 

name.  Select the Schedule side-tab and then 

click on Workspace.  Click the Select button in 

the Student Schedule section.  

• To limit the course sections to the correct 

ones, select the homeroom number in 

the Platoon field. Filter by Grade as well 

if it is a split class. Check the box “Allow 

conflicts”. 

• Click the box for each of the desired 

courses (making sure the correct grade is 

selected if homeroom is a split class). Click OK 

• You will now see the list of course sections to be scheduled.  Scroll far to the right and click Post. 

• To see the list of course sections for the student, click the Schedule side-tab.  

When registering a StrongStart student it is necessary to assign one course to allow attendance to be taken.  That 

course is XAT—EL-1. 

You will only need to schedule students if they register mid-year; Start-up scheduling is done by the MyEd team. 

After registering a new student, wait a few days and check to ensure assignment of a PEN.  If not, the Ministry 

is seeing a problem with the student information.  You may receive an email from the Ministry PEN branch.  

Email the MyEd helpdesk to resolve the issue.   
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WITHDRAW A STUDENT 

When a student is 

moving OUT OF 

DISTRICT, you must 

withdraw them. 

Follow withdraw 

check list first! -page 16 

• In the student list, check the box beside the student. 

• From the Options menu, choose Registration – Withdraw Student 

• Enter the date of withdrawal.  This is the last day of attendance or the 
last day marked absent. If a request was received from another school, 
use the day before the first day of attendance at the new school. 

• Choose a code and reason that describe the withdrawal (do not use) 

• Choose Withdrawn for the status 

• Check the box Disable related user account only if the student is moving out of the district 

• Always check the box Create former school association. This will allow access to the student for the rest 
of the school year to make any needed changes to marks or other historical records. 

 

When a student is withdrawn, their enrollment status will change from Active to Withdrawn, unless the student 

has an active secondary school association (cross-enrollment).  In that case, their enrollment status will become 

Active No Primary.  When withdrawing such a student you will see a message that you cannot change their 

status.  This is OK.  If you do not wish to see Active No Primary students in your list of students, you should use 

the Current Members filter rather than Primary Active Students. 

TRANSFER A STUDENT 

An alternative is to transfer the student.  This should be used for moves within the district.  

Follow withdraw check list first! – see page 16 

To transfer a student from his/her current school to a new 

school, contact the current school and request that they tick the 

Transfer pending checkbox and select the new school in the 

Transfer School > Name on the Student Details screen.  

The new school can then complete the transfer via Student top tab > Options > Registration > Transfer Student. 

Select the student from the list of pending transfers. 

The advantage of using the transfer process rather than withdraw/register is that more of the student’s 

information is kept intact.  For example, the student IEP is kept open and the new school can easily continue 

work on it.   
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CHECKLISTS FOR REGISTERING AND WITHDRAWING  

Registering (new or new-to-district students only): 
 

❑ Before you start, you must have a proof of DOB and Legal name in order to register in MyEd.  

(StrongStart too) 

One of the following can be used: 

o Birth Certificate 

o BC Services Card 

o Passport 

o If you do not have either document, ask parent, previous school, or StrongStart facilitator for 

one. This information is required to register a student. 

❑ Do a thorough search to ensure they are not already in MyEd (communicate with parents-ask if they 

have attended a StrongStart or previous school in BC, do some detective work) 

❑ If a NEW student has siblings already in MyEd, check the “New family member” box and search for the 

related student.  This will link contacts, phone numbers and addresses and ensure they are “shared” 

❑ Once registered, delete all emergency contacts from other districts (you will have their new registration 

forms with updated information) 

❑ Enter homeroom  

❑ Update other demographics and contacts as needed (search contacts thoroughly to make sure they are 

not already in the system). 

Do not update busing information – this is done by transportation staff 

❑ Assign courses and programs if registering mid-year 

❑ Enter PSR Inclusions 

❑ Assign permissions 

❑ Enter/change alerts accordingly 

❑ After registering a NEW student, check back in few days to see if the PEN has been assigned 

 

 

 

*If you realize you have made a mistake with a students’ first, last or middle name, or the DOB after 

registering at any point of the year, do not simply change the mistake.  You must contact the PENs 

coordinator and scan the legal ID to update their information as well 

PENS.coordinator@gov.bc.ca 

  

mailto:PENS.coordinator@gov.bc.ca
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Transferring – Students in District only 

School Transferring OUT 

❑ Ensure the resource teacher knows the student is leaving so they can update the IEP as required. 

❑ IF the student has conduct incident records, ensure the principal has had a chance to review the conduct 

records.  They may want to delete some of them. 

Review the student’s transcript records:  

o Student top-tab, Transcripts side-tab.  

o Ensure the filter is set to “Current Year” and the Dictionary is set to “All” 

❑ Transcripts Records with marks entered for ANY term:  Enter “W” in the Final field and Save. (for Grades 

10-12 enter course dates as needed). Either: 

o Grade top-tab, select each course, enter W for final grade 

o Student top-tab, transcript side-tab, enter “W” for each course 

❑ Blank Transcript Records: DELETE 

❑ In the student’s Demographics, check the box “Transfer pending” and enter the next school in the 

“Transfer School > Name” field.  

❑ Notify the school receiving the student that they can run the transfer process.  

NOTE: When the new school runs the transfer wizard it will automatically: 

• End date the previous school’s programs 

• Drop the previous school’s courses from student’s schedule 

• Remove previous Homeroom  

• Remove Next School (if applicable) 

• Remove the student from previous Groups and School/User Snapshots (if applicable) 

• Create a Former school association for the previous school until the end of the 

current year (based on district MyEd dates)  

School Transferring IN 

❑ Run the Transfer Student wizard. Use transfer CODE: Public School In Dst for both withdrawal and entry 

schools 

❑ Schedule courses and enter programs  

❑ Review PSR inclusions 

❑ Enter homeroom  

❑ Update other demographic information as needed (permissions, contacts, address, alerts, etc.) Do not 

update busing information – this is done by transportation staff  
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Withdrawing – Student is leaving District: 

Before running the withdrawal wizard:  

❑ Ensure the resource teacher knows the student is leaving so they can update the IEP as required and 

print a copy if required.  (Please remind them to end date any Active PLANS.) 

❑ IF the student has conduct incident records, ensure the principal has had a chance to review the conduct 

records.  They may want to delete some of them. 

❑ Delete all emergency contacts. Delete all contacts that are not parents. Note: if the contact is shared, 

they will not be deleted from the other students, don’t worry. 

❑ If the student has any marks entered into a transcript record, enter a final mark of a W for each course. 

Either: 

o Grade top-tab, select each course, enter W for final grade 

o Student top-tab, transcript side-tab, enter “W” for each course 

❑ If the student is withdrawing is a high school student from QJS, CSS, QDL, McN run attendance report:  

Student top tab, Attendance side tab, Class Attendance sub-side-tab.  Reports, Quick Reports, Saved 

report, click on “Student Class Attendance (Period) and finish.  Store in a folder in your office or online 

file for audit.  

❑ Check Membership > Enrollment & Schools Tab.  If the student is cross-enrolled you should check with 

the secondary (other) school to see if user accounts should be disabled.  Otherwise, be sure to check the 

box to disable related user accounts when withdrawing. 

 

❑ Withdraw the student 

NOTE: The transfer wizard will: 

• End date school programs 

• Drop school courses from student’s schedule 

• Remove Homeroom  

• Remove Next School (if applicable) 

• Remove the student from Groups and School/User Snapshots (if applicable) 

• Create a Former school association until the end of the current year (based on 

district MyEd calendar dates)  

Ensure the withdrawal process is completed correctly:  

❑ Check the “Former” student filter to ensure that the student appears 

❑ View the PSR to ensure all withdrawal information is correct (with W for final marks) 

❑ Modify the withdrawal record in the membership side if necessary 
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CROSS-ENROLL A STUDENT 

Sometimes, students take classes at your school while taking classes or receiving services at other schools too. 

The Create Secondary School Associations wizard is a way to associate these cross-enrolled students with their 

secondary schools. 

To cross-enroll a student at your school: 

1. Use School view, Student top-tab.  

2. Click Options - Create Secondary School 

Associations.  

3. The Create Secondary School Associations 

wizard appears:  

4. Decide if you are Pushing or Pulling a 

student 

a. Push- you are the primary school 

b. Pull- you are the secondary school 

5. If pushing, select school they will be cross-

enrolled with.  

6. Select the District year for the cross-

enrollment.  

7. Enter the Start date that the student will 

attend the secondary school. There may not be 

an end-date. 

8. Click the Selection option and select student. 

9. Click OK. 

10. If Pulling, click on Pull top-tab 

11. Select the District year  

12. Fill in demographics for student you want 

cross-enrolled and click search 

13. A pop-up will list the student’s name, some demographic information and contact information. Make 

sure it’s correct and click OK.  

Records of all secondary schools for a student are shown in the Student top-tab, Membership-Schools side-tab.  

You could add a record there for one of your students to cross-enroll them in another school, but that is not the 

normal procedure. 

It is NOT recommended to cross-enroll a student who will be moving to your school as a way of gaining access 

to their record early. 
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END A STUDENT CROSS-ENROLLMENT 

To end a cross enrollment at your school, select the student from the 

school and select the Membership - Schools side-tab. Enter the end-date 

and click Save.  The student enrollment status will change from Active to 

Withdrawn.  

FINDING AND EDITING INFORMATION 

MyEd normally shows information in a list format.  This might be a list of students, staff members, courses, 

sections, conduct incidents, etc.  You will occasionally want to see or make changes to a selection of records in a 

list. You can select certain records manually or with a filter, query or snapshot.   

You can also change the sort order of the list and change the fields that are shown for each record in the list (the 

field set).  Sometimes you can quickly change the information in the list using the modify list feature or by mass 

updating. 

MANUALLY SELECTING RECORDS 

You can create a list of specific students or other records by manually selecting them.  Click on the checkbox to 

the left of each of the records you want; then select Options – Show selected. 

SELECT OR CREATE A FILTER 

MyEd often displays information in lists.  If the lists are long it can be difficult to find what you are looking for.  A 

filter can help by limiting the list to only the records you are interested in.  A filter is also useful to limit the list to 

only the records you want to change.   

To apply a pre-existing filter to a list, click the   box and select the filter.  Some filters require you to enter 

information you want to search for, such as Grade = ? requires you to enter the grade you want.  Common filters 

are to show all records or only active records.  Inactive students are ones that have withdrawn but not registered 

in a different school; inactive staff members are those who have left the school. 

You can change the order of filters by clicking on Manage Filters and using the up and down buttons.  The top 

filter is the one that is used when you first log on and haven’t selected any other filter. 

 

You can add filters to your list by choosing Manage Filters and then New.  There is a long list of pre-made filters 

to select from.  You can also create your own filters by saving a query as a filter (see below). 

CREATE A QUERY 

A query is like a filter in that it limits the records shown in the list.  You create it yourself and you can use it only 

once, or you can save it as a filter.  If saved as a filter it will be run again whenever you choose it so it will always 

show current information.   
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To create a simple query: 

• From the list view, select Options – Query 

• Select the field you are searching (Tables 

contain other field options) 

• Select the operator and value to show 

what you are searching for 

• Click Add to put your criteria into the 

bottom box 

• If you have more criteria repeat the above 

steps and select either the And or the Or 

button 

• Choose which group your search should be 

based on  

• Click the Search button 

• If you want to save the query as a filter click on Save As and  

• Enter a name for your new filter 

• Check the Save as Filter button 

• Leave the Owner Type set to User unless you want to share the 

filter with other users at your school 

SELECT OR CREATE A SNAPSHOT 

A snapshot is a static saved selection of students – it doesn’t get updated 

as students are registered, changed or withdrawn.  To create a snapshot you first use any method to get the list 

you want on the screen.  Then you create a snapshot to save that list.   

SELECT OR CREATE A SORT ORDER 

The quickest way to change the order of the records in a list is to 

click on the heading in the column you want to sort by.  For 

example, to sort the list of students by homeroom, click on the 

word Homeroom at the top of the list.  Clicking a second time will 

reverse the list.  If you want to sort by two columns just click them 

in reverse order.  For instance, if you wanted the list of students to 

be sorted by homeroom, then by grade within each homeroom, then alphabetically by name within each grade 

you would first click on Name, then Grade, then Homeroom. 

Save a Sort Order:  If you find that you use a particular sort order you can save it and select it later by clicking on 

the sort button:             To save a sort order, click the sort button and select Manage Sort Orders. You can create a 

new order or edit an old one if you are the owner.  Select the fields you want to sort on and add or remover them 

to the pane on the right.  Use the Up and Down buttons to get them into the order you want the list sorted.  

Remember you can choose more fields if you select the drop down “Available Fields”.  
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Once the “Selected Fields” is what you want, name it, and click save. 

SELECT OR CREATE A FIELD SET 

Any list is made up of a number of records (i.e. students, staff members or courses) and shows a number of fields 

for each record.  The fields for a list of students might include the name, grade, homeroom, phone number, etc.  

As you are working with various lists in MyEd you will find that they are not showing the information you 

normally want to see, forcing you to click on an individual record to see the details.  For instance, the list of 

students might show the Year of Graduation, Grade Sub Level and the Unlisted Phone Number which you do not 

use and not show the name and address of the first contact, which you do use.  You can create a new field set to 

make the column lists fit your personal preferences using this button:                 

If the field set you need has 

already been created and 

shared with you, then you 

can just select it from the list 

of available field sets.  If not, 

you can create your own like 

this: 

• Click the field set 

button and select 

Manage Field Sets  

• Select a field set that 

is close to what you 

want and click Copy 

• Enter a descriptive name and select User (or School if you want to share it with other users at your 

school). 

• Click OK, return to the list of field sets, select the new one and click Edit.  

• Use the Add and Remove buttons to change the list of fields you will see.  Use the Up and Down buttons 

to change the order of the fields.  If you don’t see the field you want you may need to change the table at 
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the top of the field list.  The example on the right shows that the information about the first contact is 

found in the Emergency Contact 1 table.   

• Once you have the field set the way you want, click Save. 

If you want this to become your default, go back to Manage Field Sets and move it to the top of the list.  Note 

that as you add additional fields to your view, they may not appear on the screen unless you scroll to the right.  

This can be confusing if you have set your preferences to show many records in a list as you will need to scroll 

down before you can see the left-right scroll bar. 

MODIFY LIST 

If you need to edit the same field for many records in a list it can be time consuming to select each record, find 

the field in the details screen and edit it.  Some fields can be edited much more quickly using Modify List.  For 

technical reasons which mere mortals cannot understand, many fields cannot be edited this way.  To use Modify 

List: 

• Get the list you want to modify on the screen.  This may involve the use of a manual selection, query, 

filter or sort. 

• Select Options – Modify List 

• Click on the pencil at the top of the column you want to edit.  If there is no pencil you cannot use Modify 

List for that field. 

• Make the changes you need.  You can use Ctrl-C and Ctrl-V to copy from one row to the next. 

• When complete, click the green check mark to save your changes.  Note if the power goes out or the 

Internet disappears before you have saved your work you will lose your work, so if it is a long task save it 

often. 

MASS UPDATE 

If you want to make the same change to many records in a list you may be able to do so very quickly using Mass 
Update.  Again, this feature is not available for some fields, and there is no profit in asking why.  It is, however, 
worth remembering that this is a very powerful feature that if misused can quickly destroy a lot of information, 
so use it carefully. 
 
To mass update a field in a list: 
 

• Get the list you want to modify on the screen.  This may involve the use of a manual selection, query, 

filter or sort. 

• If you have not already done so, use Options – Show Selected to ensure that the list only shows the 
records you want to change.  Do not forget this step! If you only select the records, without “show 
selected” it will still update all records on the screen. 

• Check again that the list shows only the records you want to change.  Is it clear that there is good reason 
to be fearful about this? ☺ 

• Select Options – Mass Update  

• Select the field you want to change. 

• Enter or select the value you want to put in that field. 
(There is an advanced button on this screen but it might be wise to discuss its use with your district 
support staff before using it.)  
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• When you click on Update you will see 
messages as below.  Read them carefully 
before pressing OK to be sure that the effect 
will be what you expected.  MyEd does not 
have an Undo button.   

 

• When finished you will see the check mark stating what Mass 
Update just happened.  Make sure it’s correct:  
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INCLUSIONS 

STUDENT FILE & PERMANENT STUDENT RECORD (PSR) 

The Student File should include, at minimum:  

• Form 1704 (Permanent Student Record or PSR) which also includes:  

▪ Current student record inclusions documents as listed on the PSR  
(where applicable) 

▪ A minimum of the two most recent years of Student Progress Reports (including 
documentation to support orally communicated letter grades) or: an official copy of the 
Transcript of Grades. 

• A copy of the student’s current Student Learning Plan (SLP) - if applicable 
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PSR INCLUSIONS GUIDELINES 

 

Inclusion 
required for:  

Process Inclusion Examples & Sample Comment 

Medical 
Alerts 
(not health alerts) 

 

Received at school level 

• School Secretary enters Alert in MyEd 

• School Secretary enters Inclusion in 
MyEd 

• School Secretary files supporting 
documents in student file 

• Type 1 Diabetes – insulin dependent 

• Anaphylaxis – epi-pen with student and backup in office 

• Blood clotting disorders 

• Serious heart condition 

• Environmental allergy – peanuts 

• Diabetic care plan located in student file 

• Epilepsy Management plan located in student file 

• Hearing Aids 

• Prescribed medication 

* Any of these alerts should also include the comment “documents/Emergency 

Procedure Plan in student file” if applicable. 

Legal Alerts 
 

Received at school level 

• School Secretary enters Alert in MyEd 

• School Secretary enters inclusion in 
MyEd 

• School Secretary files supporting 
documents in student file 

• Legal name change located in student file 

• Family court order located in student file 

• Immigration documents located in student file 

• Continuing Custody Order located in student file 

• Temporary Custody Order Located in student file 

Individual 
Education 
Plan (IEP) 

Created by Resource Staff at school level 

• Resource staff communicates IEP 
creation to school Secretary (or, if you 
notice an IEP icon, make sure there is 
also an inclusion entered) 

• School Secretary enters inclusion in 
MyEd 

• IEP documentation found in MyEd BC and/or student file 

 (don’t add multiple  inclusions for IEPs for consecutive years, leave end 
date blank until no longer in use) 

Support 
Services 
Information 

Received at school level 

• Support Services staff communicate 
document to school secretary 

• School Secretary enters Inclusion in 
MyEd 

• Documents added to Student IEP 
Binder 

Created at district level 

• SLPs provide documentation to the 
Secretary of District Support Services  

• Secretary of District Support Services 
enters inclusion in MyEd 

School 

• Letter of Diagnosis from Pediatrician in student file (or IEP Binder) 

• Health Assessment Network assessment in student file 
(Northern Health, Interior Health etc.) 

• Pediatrician Assessment in student IEP binder 

• Psychiatric Assessment in student IEP binder 

District 

• Hearing Assessment in student IEP binder 

• Vision Assessment in student IEP binder 

• Occupational Therapist (OT) Assessment in student IEP binder 

• Speech Language Assessment in student IEP binder 

• Psychoeducational assessments in student IEP binder 

• Psychiatric Assessment in student IEP binder 

Homeschool 

Informed at school level 

• School Secretary enters inclusion in 
MyEd 

• School Secretary enters HS as grade sub 
level in MyEd 

• Student is registered as a home-schooler in MyEd 
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Inclusions Do NOT Include: 

 

• Letters from parent requesting no contact (it must be a Legal document)  

• Referral forms (SLP, YCW, AESW, etc.)  

• Service summaries/reports throughout the year (SLP, OT/PT, Student Services)  

• Individual Support Planning Tool (ISPT)  

• POPARD  

• Student Support Plan (SSP)  

• Supplementary Plans (behaviour plan, staff response plan, toileting plan)  

• The Needs Intensity Scale  

• Curriculum-based assessments  

• Data collection: behaviour or academic information  

• Pre- and post-assessments done to show growth on an objective in an IEP (i.e. Precision Reading, Alberta 
Diagnostic, PM Benchmarks)  

• Proof of service from in-school counselling, YCW, ABED, District Specialist Teachers, other counselling  

 

STEP 1:  Determine Inclusion Record Needs in MyEd 

Because this process is new to the district, we have to start with record checking to determine students that 

need inclusions added. Going forward this can also be a yearly check-up to make sure your data is correct.  

 

 

 

 

 

 

 

 

 

 

 

 

 

There is an SD28 Student Services – 1701 

Info field set that can help with your search. 

Student Top Tab 

Click Alerts twice to sort 

in descending order 
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* NOTE: If preferred, you can also use filters for many of these flags. These filters include:  

  - Active with Designation 

  - Grade Sub Level = ?    (HS) 

  - CYIC or YAG students 

  

If a Student has a legal alert, medical 

alert, IEP alert, or ELL alert 

they should also have a corresponding 

Inclusions Record 

NOTE: A health alert may indicate Pediatrician or 

Health Assessment Network assessments/diagnosis 

these should also have a corresponding  

Inclusions Record 

Find these filters here 

In the SD28 Student Services – 

1701 Info field set, also look for: 

Designations without IEPs  

Custody other than both parents 

CYIC “Y” flags 

Homeschool  “HS” flags 
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STEP 2:  Create Inclusion Records in MyEd 

Once you know all the students that require inclusions, you will need to create inclusion records: 

 

 

 

 

 

 

  

In Student Top Tab 

Transactions Side Tab > Inclusions Leaf 

Click Options menu > Add 
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* Office procedures will now need to include adding an expiry date to this field when a student no longer needs 

or uses an inclusion, examples:  

• A student in MCFD care is returned to parent guardianship and CYIC or YAG flag is removed – 
the expiry date on the corresponding Inclusion Record would reflect the date the student is 
return to parent guardianship. 

• A student with prescribed medications no longer requires them and the Medical Alert has 
been end dated – the expiry date on the corresponding Inclusion Record should be updated 
as well.  

 

 

 

 

  

Enter start date of inclusion 

IF there is an expiry date, 

enter it here* 

Enter the school year 

Enter the comment that 

will appear on the PSR. 

Example Comments can 

be found on pg.3 

Click Save 
Repeat this process to 

create a record for 

each inclusion  
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Example PSR with Inclusion Record 

  

This is a Medical Alert Inclusion Record, indicating that 

supporting documents are located in the Student File.  

See the Example Comments   for more 

This indicates a Medical Alert 

has been entered into MyEd.  

A corresponding Inclusion 

Record should also be entered. 
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ATTENDANCE 

START-UP ATTENDANCE 

At the beginning of the year attendance may need to be taken manually and by grade before students are sorted 

into classrooms/homerooms. Run the BC Homeroom List w. Grid report found in either the Student top-tab or 

the Attendance top-tab under the Reports menu.  

 

 

 

ENTER ABSENCES (ELEMENTARY) 

Daily Roster 

Most teachers take attendance now, so the first thing you will need to do is run a report to see who has posted 

their attendance.  

To do this, go to Attendance top –tab, click on Reports and select Daily Attendance Post Verification. Uncheck 

“Show non-posts only” and Run.  This will 

show you who has posted and at what time.   

Please note- if there are two teachers for 

one class only one will post and the second 

teacher will show up as “Did Not Post” 

although the class was accounted for 

already. 

Once everyone has posted you can go in to 

make changes from the phone calls or 

emails you would have received.  

Select the BC Homeroom List w. Grid 

report. Make sure to sort by GRADE. 
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To enter student absences/lates by class, select the Attendance top-tab and the Daily Roster side-tab. Select the 

homeroom.  You will see all students in that homeroom (make sure you are on the correct date) 

 

Click the A (Absent), L (Late) or D (Dismissal – left early) button as 

appropriate.  Enter Reason and check Excused if necessary.  If a 

child is away ½ the day, change the 1.000 portion to .5000 or 

whatever portion is correct.  

Click the save button.   

You can change the date on this screen using the arrows.  Use the 

navigation bar top right to move to the next class. 

 

 

 

Daily Office 

To enter absences for one student, select the Attendance top-tab and the Daily Office side-tab.  Select the code 

A, L or D and enter the student’s last name. A record of the absence will be created 

You can choose to show the popup-shown to the right (or click on the 

entry after its made) to enter additional information such as the reason 

or the portion of the day the student was absent. Don’t forget to click on 

save when you are finished.   

Clicking the Multi-Add button allows you to enter an absence for a group 

of students with the same reason (i.e. illness) or for multiple dates (i.e. 

family vacation.)  You can use a query to enter an absence for any group 

you have set up.  

 

ENTER ATTENDANCE (STRONGSTART) 

StrongStart centres use positive attendance, only entering when a 
student is present.  It is designed to be entered by the StrongStart 
facilitator, but can also be entered in the office.   
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To take attendance, change your view to Staff View and click on Select Teacher.   
 

 
 
Choose the StrongStart facilitator from the list and click OK. 
 
Click on the Attendance-TopTab and select the “course”:  XAT—EL – 01  
 
You will see the class list.  To mark a student present, just click the POS button.  When finished entering 
attendance for the day, click the Post button to save your work. You can only post once so make sure all 
students records are correct before POSTING 

 
To move to a different date, use the arrows or the calendar icon on the upper right of the window. 

 

ENTER ATTENDANCE (SECONDARY) 

Class Attendance 

Secondary school teachers will also keep attendance in their class, however; office staff will need to enter 

excused absences / field trips / changes /any other absences teachers will not know about. 
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• Clicking the … in the Daily Code column allows you to enter or 

edit a daily absence or late.   

• Clicking the >> for a full day absence creates a class 

attendance record for all classes that day (which will be seen 

by the teachers).  

• Clicking the … in a Block column allows you to enter a class 

attendance record in that block.  With a non-rotated 

timetable these blocks will not be ordered as the periods in 

the day so you will need to take into account the block 

rotation for the day.  If your school has a rotated timetable 

this will change to take into account the block rotation.  

• To do a multi-add attendance (i.e. for multiple students with 

the same reason-sick- or if one class is going on a field trip 

and the other teachers need to know)  

o click options > BC Multi-Add Class Attendance. Select 

Student IDs in “Students to include” 

o type IDs in “Student IDs” (note each student ID needs a new line entered down) 

o enter date(s), periods, code, reason, then Run 

 

STAFF ATTENDANCE (ASSIGNING TOCS) 

When a teacher is away,  a TOC needs to replace the teacher in order for attendance to be taken. 

In the Attendance top-tab, Staff Roster side-tab, click the TOC button for absent teacher and select the TTOC in 

the Daily Replacement field. You can select multiple days, and/or specific classes for Secondary blocks if you 

check the Period Replacement box.  

If you cannot find the TOC name you are looking for, try and uncheck the “School staff only” and “Free staff only” 

and select “All Staff” under the Selection based on drop down menu. If you still cannot find them, contact your 

MyEd Support Team.  
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MARKS 

ENTER STUDENT MARKS  

To enter student marks select the 

Grades top-tab and the Grade Input side 

tab, Input Grid leaf.   

Select the term at the top.  Enter marks 

in the Grade column using the 

appropriate grade scale.  When finished, 

post the grades to the report card with 

Options-Post Grades. (Do not 

add/change marks without teacher’s knowledge) 

Once grades are posted the green thumbtack will change to red.  

The blue exclamation marks beside the grades are an indicator to 

the teacher that the marks have been entered by the office. 

To post the grades for all classes select Options-Post Grades from 

the list of classes. To post grades for a selection of classes, select 

the desired classes with Options-Show Selected and then use Options-Post Grades. 

 

PRINT LEARNING UPDATES  

Select a class and go to the Roster side-
tab or select the Student top-tab and 
filter to the desired students.  Use the 
Reports menu to select Learning 
Updates. You can use the top tabs to 
select the term(s) and students, but 
you probably don’t need to.  It will 
print for the current term and the 
currently selected students. 

Under User Specific Parameters, check 
the boxes to show what you want to 
see.  You want to uncheck Display Final 
unless it’s the final report card.  
Uncheck Display Class Teacher Name 
for Elementary School.  You may want 
to choose to not display Programs and 
Plans and include a box for the 
principal signature.  
 
 
 



38 
 

 
 
K-9 schools can include an explanation 
of the performance indicators using the 
Descriptor Selection tab. 
 

 

 

ENTER COMMENTS IN A SCHOOL COMMENT BANK 

Go to the Admin top-tab, Comments side-tab and click on School Comments.  Select the Codes leaf and use 

Options – Add to add a new comment.  The ID field can be a unique number that can be used to search for a 

specific comment.  The Preview is what teachers will see when choosing the comment from a list.  The first 

category field should be set to School.  The next two are used to narrow down the list when browsing for a 

comment (may need to change the template view to see category 3 field). 

You can customize comments with the following tokens: 

Name   {{person.firstName|lower|capitalize}} 
his, her  {{person.genderCode|gender:his, her|lower}} 
he, she  {{person.genderCode|gender:he, she|lower}} 
himself, herself {{person.genderCode|gender:himself, herself|lower}} 

CREATING REPORTS, EXPORTS AND CHARTS 

PRINTING REPORTS 

Reports in MyEd are context sensitive, which means that instead of having one huge reports tree from which to 

select from, there are various reports that available from different screens.  This is normally helpful, but 

sometimes it is not obvious which screen should hold which reports.  The reports in MyEd are far from complete 

at this time.  More are always in the process of being developed.  In addition, school and district staff has the 

ability to develop their own reports and share them to the school or the district. 

Most of the reports you will need are located in the Students top-tab.  Click “Reports” in the sub-menu and select 

the report.  Since you may want many of your reports for only a select group of students, you first select a group 

of students using sorting techniques such as using the checkboxes and Options>Show Selected, filters, or queries.  

Some useful reports we have found are: 

 

On the School top-tab: 

Enrollment Activity 

 Shows when students have enrolled (E), withdrawn (W) or changed their status (S). 

Enrollment Breakdown 

Shows the students broken down by any field you choose and also by grade or age and by 

gender.  If you choose the Homeroom field it produces a report showing number of students in 

each grade in each homeroom.  If you choose Aboriginal Ancestry it produces a report showing 
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number of students in each grade with each Aboriginal Ancestry code. 

 

On the Students top-tab: 

BC Student Information Verification Form 

Shows information presently in MyEd and provides space for parents to fill in missing or changed 

information. 

Permanent Student Record 

Note that elementary academic history has not yet been imported from BCeSIS 

Permanent Student Record Labels 

Labels to put on student cumulative file 

Report Card 

K-9 Three Term 

 

On the Students top-tab, under Other Jurisdictions: 

BC Attendance History  

All absences for a specified date range; can be sorted by Name Grade or Homeroom.  It includes 

details of all lates and absences and uses one page (or more) per student. 

Birthday List 

The students with birthdays in a specified time period. 

Enrollment Activity Report 

The students that have been registered or withdrawn in a specified time period. 

Homeroom List  

A list of the students in one or more homerooms 

Student Alerts 

Lists of students with a specified alert 

Student Contacts 

A list of contacts for each student; can be sorted by emergency contact order 

Student List 

A list of students and PENS that can be sorted in various ways 

Student Profile 

Shows basic demographic information for each student - one page per student 

 

 

Some reports are available in the Attendance top-tab: 

 

Attendance call sheet 

Shows students absent on a specified date with parent info 

Attendance Homeroom Input 

A weekly input sheet for teachers to mark absences 

Attendance Class Room Input 

A weekly input sheet for StrongStart teachers to mark students present 
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EXPORT TO EXCEL 

It is easy to export any information you see as a list in MyEd to Excel.  Just click the printer icon           and select 

CSV.  A window will open and you will see your exported file at the bottom of it.  Click on it and it will open in 

Excel.  The CSV file will be saved in your downloads folder with a long meaningless name.  After you have edited 

it in Excel you can save it in a better location with a meaningful name.  Change the file type to Excel Workbook 

(.xlsx) 

To make the exported data more useful you can use a different field set to change the columns that will be in the 

spreadsheet and use a filter or query to change the students included – the rows in the spreadsheet.   

CREATING QUICK REPORTS 

A quick report is a way of printing information for the list shown on your screen.  

 To learn how to create quick reports, click Help – Basic Navigation p 49.  

EXPORT MINISTRY DATA (1701, CLASS SIZE, SADE, TRAX) 

The process to report MyEd 1701 or Class Size data to the Ministry is the same as from BCeSIS except the export 
is from MyEd.   The exports are found in the Student top-tab by selecting Options – Exports.  For the 1701 data 
select BC1701 STD Extract to upload to the Ministry web site or others to view the data at the school.  There is a 
Class Size Verification report to view the data at the school and a Class Size export to upload to the Ministry web 
site. 
 
There are separate documents on www.myeducationBC.info with details for 1701, SADE and TRAX reporting. 

CONDUCT    

ENTERING CONDUCT INCIDENTS FOR ONE STUDENT 

To enter a conduct incident, start with one of these 

methods: 

• Select the Conduct top-tab, Office Input side-tab, 

enter student’s last name and select the student 

Or 

• From student demographic details select the 

Conduct side-tab and choose Options-Add 

Once in the incident screen, follow these steps:  

• Enter or select the code best describing the incident 

• Add additional codes if applicable 

• Enter the date, time and location of the incident  

(t = today, t-1 = yesterday) 

• The owner will be a school administrator 

• If the incident was reported by another staff member, enter that person’s name in the Referral Staff box 

• If there was a student victim, select the student’s name 

http://www.myeducationbc.info/
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• If the student has lost privileges to attend school activities the date that privileges will be returned can be 

entered (optional)  

• Type a detailed description of the incident 

The next step is to enter any actions that are taken:  

• Select the Actions sub-top-tab and click the Add button on the 

bottom right 

• Enter a code, date and description.  If the action has been 

completed, check the checkbox.  

• If the action is a detention or suspension, enter the start date 

and the length.  The dates will appear on the calendar 

• Enter a description of the detentions or suspension. 

ENTER CONDUCT INCIDENTS FOR MULTIPLE STUDENTS 

If multiple students are involved in an incident, enter it like this: 

• In the School View > Conduct top tab, click the Multi-Add button. 

• Click Selection in the popup at the top of the screen.   

• Select the names of the students from the pick list.  Note that the check boxes enable selecting as many 

students as necessary from the list. 

• Verify that the correct number of students has been selected, as the names of the students do not 

appear on the list until the incident and action have been saved. 

• Check the Shared Incident ID box to assign the same incident ID to the 

records of all the students involved.  De-selecting the field assigns a unique 

Incident ID to each student’s record. 

• Click OK. 

• Complete the fields on the Incident tab, which are the same as viewed on 

the entry screen for a single student. 

• STOP. DO NOT SAVE. 

• Go to the Actions tab BEFORE saving and complete the popup, which is the same as the one viewed for 

entry of an Action for a single student. 

Note:  Important!!  If the Incident is saved prior to clicking on the Actions tab, the actions will need to be entered 

on each student’s record individually. 

• After saving the multi-add entry, go to the list of incidents entered for that day and re-open the record 

for one of the students entered in the multi-add.  Enter an additional action for that student. 

DELETING A CONDUCT INCIDENT 

If a conduct record is entered in error, it can be deleted from the data base in any one of three ways: 

1. Conduct top tab > Select date Incident occurred > Select and check the record to delete > Options - 

Delete. 

2. Conduct top tab > Incident History side tab > Select the record > Options - Delete. 
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3. Student top tab > Select the student > Conduct side tab > Select the record > Options - Delete. 

DETENTIONS AND SUSPENSIONS 

Attendance 

• When an Action Code that results in an absence from school (such as Suspension) is used, MyEd marks 

the student absent on the designated days in both the attendance office and on the Attendance Input 

screens of the student’s teacher. 

Detention 

• When a student is assigned to Detention, the student’s name is automatically added to the detention list 

viewed from the Conduct top tab > Detention side tab. 

 

Taking detention attendance 

• When a student reports to detention, the detention supervisor checks the appropriate box at the far 

right side of the screen.  The Detention Count is reduced by one.  

• Use the Code dropdown at the upper right corner of the screen to filter the list to specific detention 

types. 

• If necessary, the detention supervisor can enter a note by clicking on the pencil icon at the far right and 

entering a comment in the text box. 

STUDENT CONDUCT REPORTS 

Conduct top-tab > Incident History side tab  

• The Conduct Action List report shows all actions that are in effect 

• The Conduct Totals report shows how many of each type of incident has 
occurred or action has been taken.  This can be a summary report for the 
school or broken down for each student, each referring staff member or 
each location in the school.  

• Suspension notice prints a letter to send to student’s parents, although our schools would likely send 
something much more personalized.    

 
To print all the incidents involving a student, select the student from the student list and use the Conduct History 
report found in the Conduct side-tab. In addition, you can print a report or chart from any list you see on a screen 
by selecting Reports - Quick Report or Quick Chart. 
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SPECIAL EDUCATION 

Information about special education designations and student IEPs (inclusive education plan) will normally be 

entered into MyEd by resource teachers, with the help of district student services staff.  If a student has a special 

education designation you will see the           alert and if the student has an IEP PLAN you will see the             alert.  

To see the student’s designation use the 

Documents side-tab and then select Plans and 

Details.   The Active (in-use) PLAN will have a 

PlanName, and the Status will be Active. 

Click on the PlanName that is Active and you will 

see the current PLAN for that student. 

PRINT A STUDENT PLAN 

The student IEP PLAN is shown in the series of horizontal tabs 
on the screen at the right.  To print it, select Reports – Inclusive 
Education Plan Report.  Select PDF and click Run. 

 

ENTER AN INCLUSION FOR A PERMANENT STUDENT RECORD 

To enter an inclusion for the Permanent Student Record, go to 
the Student top-tab, Transactions side-tab, Inclusions leaf.  Use 
Options – Add to add an inclusion.  To appear on the PSR you 
must enter Inclusion # as the event type, where # is the 
number of the inclusion.  

SENDING EMAILS TO PARENTS 

MyEd can be used to send email to 

parents for distribution for newsletters 

and many other purposes. 

Emails will only be sent to contacts that 

have a valid email address entered and 

have the Receive Email box checked.  For 

this reason, you should not check this 

box for Emergency contacts, or anyone 

else you do not want to receive 

newsletters.  

To send an email to all parents, go to Student Top tab, Options, Send Email. Make sure Contacts is checked and 

Students is unchecked.  

*Note- Parents will not be able to reply to this email, so maybe let them know in the email you send them. 
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TASKS TO BE DONE THROUGHOUT THE SCHOOL YEAR: 

LATE AUGUST – BEFORE THE SCHOOL YEAR STARTS 

CHECK THE SCHOOL STAFF 

Check that all your staff are showing in the Staff top-tab.  Please do not add or delete staff.  Instead, contact 

district MyEd support to make these changes. 

EARLY SEPTEMBER – SET UP FOR NEW SCHOOL YEAR 

SET UP SCHOOL STRUCTURE FOR NEW YEAR 

In Schedule top-tab, Structure–Terms side-tab, use Options-Add to add the schedule term.  If it is already there, 

set the dates for the school year and save it again. 

 

In Schedule top-tab, Structure–Days side-tab, use Options-Add to add the day. 

 

In Grades top-tab, Grade Terms side-tab, use Options-Add to add the three terms with appropriate dates. 

 

Go back to Schedule top-tab, Structure–Terms side-tab and click on the FY term.  Check that the cover map boxes 

are checked. 

On your list of students, select a field set that includes the Calendar field (i.e. 1701 Info).  Check that all students 

have the value Standard assigned as a calendar.   

You should also check that the school has a default transcript set in School top-tab, Setup side-tab, Details.  

Select the one that you will use most in your school. 
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CREATE HOMEROOMS AND ASSIGN STUDENTS TO HOMEROOMS 

To create a homeroom, Go to the Staff top-tab and the details screen for the teacher.  Enter a number into the 

Homeroom field and check the Primary Homeroom Teacher box. This can also be done on the staff list using 

Modify List.  If multiple teachers are assigned to the same homeroom, they will both see these students in the 

Students top-tab with the Students in my Homerooms filter. Only one teacher should have Primary Homeroom 

Teacher box checked. They will both appear on the report card. 

To assign students to homerooms, use either Modify List or Mass Update on the student list.  You can also assign 

a homeroom to an individual student on the demographic details screen. 

UPLOADING STUDENT PHOTOS 

Before uploading photos the picture files need to be named with the 

student numbers (i.e. 123456.jpg).  If the individual picture files are 

more than about 50 – 70 KB in size you should select all the files in 

Windows Explorer, right click, select Resize Pictures and set the 

options as shown at the right.  

If you have multiple photos they need to be put into a compressed 

ZIP file.  Just select all the files in Windows Explorer, right click and 

select Send To – Compressed (zipped) folder. 

To upload an individual student’s photo: 

Select the student, click the Details side-tab and click on the old 

photo or the spot where a photo should be.  Click Choose File, find 

photo in files --Open, and click Import. 

To upload all student photos: 

On the Student top-tab select the filter Primary Active Students.  Then select Options - Import Photos.  Click 

Choose File to find the zip file containing the photos. Select Pupil# in the Filenames based on field and click OK. 
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CREATING STUDENT GROUPS  

You can create a MyEd group for any group of people that need to share 
information or be treated differently.  Examples would be all Aboriginal students 
or the students seen by a particular Education Assistant.  Groups are used to give 
Education Assistants and other support staff access to the students they work 
with. To create a group, click on the School top-tab and the Groups side-tab.    

Enter the information for the group as shown at the right.  A staff member 
entered in the Adult Responsible field can be given access to only the students in 
the group.  Click Save 

To add students to the group, Select the Members  
leaf and Options-Add.    By selecting the Member Type you can select individual 
students.  If an EA or AbEd staff member wants to see the group, they have to be 
added here using the Member Type of Staff.  You will need to check the 
Administrator box for staff members. 

SEPTEMBER, FEBRUARY – PREPARING FOR AND EXPORTING 1701 

Well in advance of the 1701 snapshot date you will want to do 1701 reports available using Reports – Ministry 

Reporting.  There are separate reports available to check each of the areas of 1701 information.   On the snapshot 

date do the export using Options – Exports – BC 1701 STD Extract.  If the exported file does not have the correct file 

name you will need to rename it to your school number (i.e. 02828034.STD).  This is not a human readable file and 

is meant only to be uploaded to the Ministry web site. The link is on the MyEd page on our web site. 

  

You can then 'print' (as PDF) the reports from the web form.  (I suggest you save the final set of those reports for 

future reference.)  If you need to make changes you can either make the changes to MyEd and re-export and upload 

a new STD file, or you can make the change using the ministry web form and then make the same change in MyEd.  

If you have any enrollments or withdrawals you will need to choose the second option – make the changes on the 

ministry web site.  https://www2.gov.bc.ca/gov/content/education-training/k-12/administration/program-

management/data-collections  

 

Once the principal is satisfied that the data is accurate, you will print to PDF your final set of reports and then export 

the data from the ministry web site.  This will create a file with a name like 02828099.VER.  That is the file you need 

to email to the MyEd team. 

 

You will be given a date that the files are due to the district.  On or before that date you should have sent the .VER 

file the the MyEd team.  Any changes after that date will be made by the district – email the MyEd team with any 

changes.  

FEBRUARY – KINDERGARTEN REGISTRATION AND PREPARING FOR NEXT YEAR 

When students who have never attended a StrongStart centre are registered for next year’s Kindergarten class 

they should be given a status of PreReg and a grade of EL.  The registration date should be set to the date the 

parent registered the student.   

https://www2.gov.bc.ca/gov/content/education-training/k-12/administration/program-management/data-collections
https://www2.gov.bc.ca/gov/content/education-training/k-12/administration/program-management/data-collections
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The YOG should be appropriate for 5 year olds so that at year-end rollover their grade will be changed to K.  A 

student entering Kindergarten in the 2022-2023 school year should have a YOG of 2035.  To change the YOG for a 

student, select the student from the student list and use Options – Show Selected; then use Options – Registration 

– Promote/Demote Student.  

All students should have their Next School value 

set.  This can be seen using the Pre-Transition 

filter, and can be changed using Mass Update or Modify List for students staying within the district.  Students 

moving out of the district can have their next school set on the demographic details screen. 

Kindergarten students coming from a StrongStart centre should have the Next School field to the school they will 

be attending next year.  They will then show in the new school on the student list using the Next Year Students 

filter. 

OTHER SOURCES OF INFORMATION: 

Follett Aspen Help - Online Help, User Guides, Quick Reference Cards, Videos and Training Tools 

SD28 Training and Reference Material:  https://www.sd28.bc.ca/myeducation-bc  

Provincial MyEd Resources:   http://www.myeducationbc.info/    (Select Resources – School User Resources) 

FOIPPA Privacy Training Videos:  http://mytrainingbc.ca/myedPOI/ 

https://www.sd28.bc.ca/myeducation-bc
http://www.myeducationbc.info/
http://mytrainingbc.ca/myedPOI/

